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TemplateToaster Documentation -  A Quick Introduction
 

Template, Theme and Websites in Three Steps:
 
(a) Download and Install TemplateToaster on your computer. We offer unlimited trail.
(b) Design the template/theme/website from Scratch or Go with Sample template/theme/
website.
(c) Export the template/theme and install  it to the CMS or upload the HTML Website to your
hosting server.
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TemplateToaster -  Installation Guide

 
 

TemplateToaster runs on every machine with following operating system:
- Windows 8, Windows 7, Windows Vista, Windows XP with service pack 3.
 
With these requirement met, we are ready to install TemplateToaster. To begin with
installation, we'll first need to download the TemplateToaster.
1.)     Download the latest installation package from TemplateToaster website http://
templatetoaster.com/download  and save it on your computer.
2.)     Double click to run the TemplateToaster setup and follow the standard instructions.
2.)     Launch the TemplateToaster once the installation is finished
 
TemplateToaster Editions:
 
TemplateToaster is available in two Editions: Standard Edition and Professional Edition.
Professional Edition has some advance features. Details are available at http://
www.templatetoaster.com/purchase
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Activating a License

 
You can purchase the activation key at given link http://templatetoaster.com/purchase. To
activate TemplateToaster, perform the following actions:
1.)     Go to File menu and click on Activation option.
2.)     Enter your Activation key and click on Activate button.
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Select Template Type

 
Select one of the option to start with any template.

Joomla

Joomla is a free and open source-content mangament system(CMS) for publishing web content.
-     User Friendly
-     Strong Developer Community
-     Extension Variablity
-     Strong Content Management Capabilities
Example : Support E-Commerce, Social Networking and more.
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Wordpress

Wordpress is a free open source blogging tool and content-management system(CMS), which
runs on  web hosting services.          
-     Multiple Authors
-     Huge Plugin Library
-     Strong SEO Capabilities
-     Easy Customization
Examples : E-commerce, Social  Networking, Blogging, New Sites, Video sites, Social
Networking, etc.

Drupal

Drupal is  a free, open source software that can be used by individuals or group of users, even
those who lacks technical skills, too easy to create and manage many types of web sites.
-     Extremely Flexible
-     Developer Friendly
-     Strong SEO Capabilites
-     Stability
-     Enterprise Friendly
Examples : Multiple user sites, Online stores, etc.

Magento

Magento is an open source e-commerce web application. It uses the entity-attribute-value (EAV)
database model to store data.
-    Templates with Flexibility
-     Automatic Integration with Google Services
-     Supports variety of Payment options
-     Add to wishlist and 'Send to a friend' option for social shopping
Examples : Business websites, Online Stores , etc.
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E107

E107 is a free, open source and easily customized content-management system(CMS)
designed for maximum flexibility and ease of use.

            -     Superior plugin architecture
-     Multiple- Language Support
-     Intuitive  administration area
-     User registration system
Examples : For Information websites like News site and Music albums.

HTML

Hyper Text Markup Language, a standardized system for tagging text files to achieve font, color,
graphic and hyperlink effects on World Wide Web pages.
-     Performance (There is nothing that will run  as fast as HTML static pages)
-     Vulnerabilites (Static html pages are much less likely to be hacked as compared to script
page)
-     Easy Template Design process
-     Most powerful SEO support
Examples: All kinds of websites

Open your Project

Select this option to open an existing TemplateToaster Project file.
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Creating a Project

 

Start From Scratch

"Start From Scratch" option allows you to start designing a website, template or theme from
scratch.
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Go With Sample Templates

"Go with Sample Templates" option allow you to modify a predesigned sample template as
per your own requirement.
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Design  your Template

 

General

General Tab includes the various options such as Suggest Design, Color Themes,
Predesigned Templates, Template Type, etc.      More

Body

Body Tab includes the various options such as Suggest Body, Color, Gradient, Images,
Textures, Effects, etc. for Body or Background of a template or website.          More

Page

Page Tab includes the various desiginig elements like Suggest Page, Color, Gradient,
Images, Textures, Border, Page Margin, Width, etc. for Page part of a theme, template or
website. More

Header

Header Tab includes wide range of options such as Suggest Header, Header Position,
Slideshow, Navigation Buttons, Foreground Image, Text Area, Title, Slogan, etc. for Header
part of a theme, template or website.  More

Menu

Menu Tab includes the various designing elements of Menu such as Suggest Menu, Color,
Foreground Image, Text Area, Sub-menus, Height of Menu Buttons, Width, Margin, etc. for
Menu part of a theme, template or website.     More

Sidebar
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Sidebar Tab includes the wide range of designing option such as Suggest Sidebar, Layout ,
Sidebar Height, Margin, Padding, Color, etc. for Sidebar or Side-Column of a theme, template
or website.     More
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Modules

Modules Tab includes the various options such as Suggest Modules, Color, Header
Properties, Container Properties, Content Properties, etc. for Sidebar Modules.     More

Sidebar Menu

Sidebar Menu Tab includes the various options such as Suggest Sidebar Menu, Header
Properties, Container Properties, Menu Button Properties, Expand Horizontally , Expand
Veritcally, etc. for Vertical Menu which is loacted in Sidebar or a Website or Template.     More

Content

Content Tab includes options for Content part of a tempalte or site such as Suggest Content,
Post Properties, Quick Styles, etc.          More

Module Position

Module Position/Widgets/Regions Tab includes the various options for adding new Module-
Positions/Widget-Areas/Regions and editing existing ones in a Joomla, Wordpress or Druapl
theme Respectively     More

Elements

Elements Tab includes the desiging of various elements such as Buttons, Text Box,
Pagination, Breadcrumbs, Blockquote, Radiobutton & Check Box.          More

Footer

Footer Tab includes the various options such as Suggest Footer, Footer Layout, Footer
Background Image, Effects, Footer Text Areas, Footer Typography styles, Footer Links, Lists,
etc.          More

Responsive Layout

Responsive Tab includes the various options to apply and view your design on Mobile,
Minitab, Tab and Desktop.     More
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General Tab

Suggest Design

On clicking this button TemplateToaster will show you some template design
suggestions.

Color Scheme

This option shows various inbuilt color schemes. You can edit the existing color schemes &
can add a new color scheme as per your own requirement.

Templates

These are the pre-designed TemplateToaster templates which you can use as it is or modify
according to your need.

Layout

Layout button will help you to choose the Layout for your
website.
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Sidebars

Sidebar is a vertical column in a template/theme/website for displaying widgets/modules on
the sides of main content of the web page. We usually provide at least one sidebar at the left
or right of the content. Sidebars usually contain widgets/blocks/modules that an administrator
of the site can customize.

 

Type

Just with the single mouse click, user can directly switch from one template type to another
one, for example from Joomla to WordPress and so on.

Google Web Fonts

Google Web Fonts gives you the freedom of virtually thousands of web safe fonts,
TemplateToaster allows you to add desired font into your collection,  Just copy and paste
desired font in the textbox against various elements to change their font-family.
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Headings

Click on this option to change the text styles of Headings(like H1, H2, H3...).

Text

Click on this option to change the text styles of document(like Paragraph,
Content...).

Complete

Selecting this option will let you to change the text styles of individual elements of whole
document.

Bookmark

Bookmark option allow you to save a part or a complete template for later
use.



 

17  | TemplateToaster

 
Body Tab

 

Suggest Body

It will show you the different body design suggestions for your template/theme/website on
every click, from which you can select the best suited body design.

Color

With color option you can change the background color of body of your template/theme/
website.      More..

 
No Color:
Select this option to apply transparent background.
 
More Color:
Select this option to use wide range of color collection available in Color Picker.    
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Gradient

  Use this option to apply gradient effect to the body design.
 
More:
Select this option to apply advanced gradient effects.    
More..

 

Image

Select this option to apply background image to the body background part.
 
More:
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Texture

This option is to apply texture effect to the body design.
 
More:
Select this option to modify texture settings according to your requirement.    
More..

 

Effects

Select this option to apply effects on body background.  
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More:
Additional Effects options are under more.     More

Fixed  Layouts

By choosing Fixed type, the body background will be fixed with regard to Browser
Viewport.

Scroll Layouts

Choosing this option , the body background will scroll along with the elements in Browser
Viewport.

Bookmarks

Body Bookmark option allow you to save the Body of the current tempalte for later
use.
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Page Tab

 

Suggest Page

This option will show you the random design
suggestions.

Layout

In Fixed-width Layout, the dimensions of the site is bound to a certain number of pixels.
            In Fluid-width Layout, the dimensions are calculated in percentage in Web Browser.

Border

From here you can apply the border on your page layout and choose what sort of border you
would like to apply. You can customize the appearance of border using various options available
like style, thickness, radius and color.      More..

Width

This option will let you to resize the page width.
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Margin

This option will let you to specify the top and bottom margin of the page.

Color

Choose this option to change the background color of your page design.
 
No Color:   
Select this option to apply transparent background.
 
More Color:
Select this option to use wide range of color collection available in Color Picker.          More..  
   

Gradient

Use this option to apply gradient effect to the page design.
 
More: 
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Select this option to apply advanced gradient effects.    
More..

Image

Select this option to apply background image to the page part.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the page design.
 
More:
Select this option to modify texture settings according to your requirement.    
More..
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Effects

Select this option to apply effects on page background.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

This option is to apply shadow effect to your page layout.
 
More:
Select this option to apply custom shadow effect  to the page layout.    
More..
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Header Tab

 

Suggest Header

It will suggest you a new design of Header, on every
click .

Header Position

This option provides the various header positions such as Header Above Menu, Header
Below Menu, Menu Inside Header or No Header.

Height

Choose the height option to increase or decrease header height.

Border
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You can apply border to the Header, by using this option. You can customize the appearance
of border using various options available like style, thickness, radius and color.      More.
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Width

Set the header width according to your design.
Full Width Header means Header width will be equal to your browser window.
Equal To Page Width means Header width will be equal to your page width.
Custom Width will let you to resize  the Header width according to your
requirement.

Margin

 
This button is used to set the Header margin. You can customize the margin from different
sides i.e. top, left, right and bottom.

SlideShow Controls

Slideshow  is a collection of images that are presented on your website in a pre-arranged
sequence. Slideshow run automatically, so you don't need to use the mouse or keyboard to
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move from one picture to the next. However, if you want to move to the next slide or previous
slide without waiting, you can do so by clicking the slideshow next and previous buttons.
This option will provide you the feature to add the slideshow to the header by adding different
slides according to your requirement.

Settings

Transition effect will let you to give effects into your slides. By default , we have three
transition effects i.e. None( for Simple slideshow),Fade(for Fade-in effect) and Slide-In( for
moving slide up to down).
Transition Duration, will set the time duration between the slides. By default we have Fast,
Medium & Slow transition duration. But besides that, more option will let the user to set
transition duration for slides as per requirement.

Navigation

Navigation will let the user to customize the appearance of Pagination bullets for the slides.
 
Pagination-Types:
Select the type of bullets that you want to display in slides.
 
Normal:
This option allows you to customize the appearance of normal pagination bullets for the
slides.
 
Selected:
This option allows you to customize the appearance of selected pagination bullets for the
slides.

Buttons

Show:
Check/Uncheck the show option, to display/hide the Left/Right Scroll buttons.

Button:
You can customize the look of the Left/Right Scroll buttons by using this option.

Inner Arrow:
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Click on this option, to customize the arrow placed inside the Left/Right Scroll buttons.

Color

Choose this option to change the Background color of your header.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the header design.
 
More: 
Select this option to apply advanced gradient effects.    
More..
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Image

Select this option to apply background image to the header design.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the header design.
 
More:
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Select this option to modify texture settings according to your requirement.    
More..

 

Effects

Select this option to apply effects on header background.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect to your header layout.
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More:
Select this option to apply custom shadow effect  to the header layout.    
More..

Foreground Image

 
In addition to the header background image TemplateToaster allows you to insert foreground
image(s) in header to make template/theme/website more professional and easy to
understand.     More..

Text Areas

Text Area is another convenient option to place the text in the header. Just click on this button
and draw an area of dresired dimentions on the header.  Double click on the text area to
modify its dimentions, add text, add background image, colour and lot more. Text formatting
can also be done.

Background
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This option will let you change the backgound color of
TextArea.

 

Effects

Select this button to apply effects on TextArea. To add texture effect, use Texture button.
Effects button is used to apply effects on TextArea. Shadow button is used to apply shadow
effect on TextArea
 

More..
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More..
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More..

Border

To apply border on TextArea, use this option.    
More

Title

Website title options. You can hide the title from here and can apply lot of additional options
like text formatting, font selection and so on.

Slogan

Website slogan. This is also optional. Text formatting can be done according to user
requirements.
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Logo

Logo is a graphical mark or emblem to represent the organization. User can use the pre-
deisgned logo or upload his/her own designed logo from More option. Logo can be resized
accordingly.

Bookmarks

Header Bookmark option allow you to save the Header of the current tempalte for later
use.
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Menu Tab

 

Suggest Menu

It will suggest you a new design of Menu on every
click.

Menu Position

This option provides the various Menu positions such as Menu Above Header, Menu Below
Header, Menu Inside Header or No Menu.

Height

Users have full control on Menu height. A user can choose the height from given values or
can apply a custom height according to the requirement from More option.
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Width

Set the menu width according to your design.
Full Width means Menu width is equal to your browser window. 
Equal To Page Width means the Menu width will be equal to your page layout.
Custom Width option will let you to resize the Menu width according to your
requirements.

Border

Designs the border of Menu. You can customize the border from different options available.   
  More.

Margin

This button is used to set the Menu margin. You can customize the margin from different sides
i.e. top, left, right and bottom.
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Color

Choose this option to change the color of your Menu design.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Menu design.
 
More: 
Select this option to apply advanced gradient effects.    
More..
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Image

Select this option to apply background image to the Menu design.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the Menu design.
 
More:
Select this option to modify texture settings according to your requirement.    
More..
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Effects

Select this option to apply effects on Menu background.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect to your Menu layout.
 
More:
Select this option to apply custom shadow effect  to the Menu layout.    
More..



 

42  | TemplateToaster

Foreground Image

Users can also insert the foreground-image in Menu.    
More..

Text Areas

Text Area is a convenient option to place the Text Box on the Menu Strip.Use this option
to draw text area in your Menu. Double click on added Text Area box to edit the text. Text
formatting can also be done.

Background

This option enables you to add or change the background color of Text
Area.

Effects

Select this button to apply effects on Text Area. To add texture effect, use Texture button.
Effect button is used to apply effects in Text Area. Shadow button is used to apply shadow
effect in Text Area.
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More..
 

More..
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More..
 

Border

To apply border on Text Area, use this option.    
More.
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Menu Button Properties

Separator:
Separator provides a horizontal or vertical dividing line. It is most commonly used in Menus
and Tool bars. Here Red lines in Menu depicts the Separator. Styling can also be done for
Separator.
 

 
Height:
Pre-defined values of height will let you to set the height of Menu buttons. Click on More
option to set your custom values.
 
Margin:

This can be used to apply Margin to Menu buttons from left and right side.
 
Padding:

This can be used to apply Padding to Menu buttons from left and right side.
 

Alignment:
This option is to aligh the menu buttons on left, middle or right of the menu strip.
Horizontal Alignment is used to align the buttons horizontally. It includes left, center & right.
Selecting left option, will move the menu buttons on the left side. Selecting center option will
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move the menu buttons to the center. Selecting right option will move the menu buttons on
the right side.
Vertical Alignment is used to align the buttons vertically. It includes top, center & bottom.
Selecting top option, will move the menu button on top. Selecting center option will move the
menu buttons to the center.Selecting bottom option will move the menu buttons on bottom.
 
Icon:
User can place the colorful icons in menu buttons. Icon styles can be customized using the
additional options here.
 
Arrow:
Arrow appears besides the menu items having sub-menu items.  User can also apply styles
to the arrow.
 
Texture:
Texture are the abstract effects. User can apply texture in menu buttons.

Background

User can apply background color to all three states of the menu
button.
 
Normal:
Background color for normal or passive menu button.
 
Hover:
Background color for the menu button on hover.
 
Active:
Background color for the active menu button.

Border

You can also apply border to menu button. The appearance of the menu button border can be
customized.
 
Normal:
Border properties for normal or passive menu button.
 
Hover:
Border properties for the menu button on hover.
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Active:
Border properties for the active menu button.          More..

Typography

Text Style can be changed in menu button, in all the
cases.
 
Normal:
Text styles for normal or passive menu button.
 
Hover:
Text styles for the menu button on hover.
 
Active:
Text styles for the active menu button.

Mega

 
Mega menu is a growing trend in web design for sites that involve a lot of pages and/or
products. Mega menu is able to improve navigation and usability. You can apply or customize
the Mega menu from here.
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Vertical

Vertical menu are efficient for average size websites. You can apply and customize the
Vertical menu styles from here.

Horizontal

When you have a group of list items on your site that you want to draw special attention to, it
can be easily done through horizontal menu. Horizontal menu displays items in a horizontal
row behind its parent item. You can apply and customize the Vertical menu styles from here.

SubMenu Container

Submenu is a secondary menu that appears while you hover an item on the primary menu.
Users have the full control to change the styling of Submenu items. Submenu container is the
container for the submenu items.

Background:
User can change the background color of sub-menu container.

Border:
User can also customize the border of sub-menu container.

Shadow:
To apply the shadow effect to the sub-menu container.
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SubMenu Item

Height:
Select this option to increase/ decrease the height of sub-menu items.

Width:
Select this option to increase/ decrease the width of sub-menu items.

Background:
To change the background color of sub-menu items, click on this option.

Shadow:
To apply the shadow to sub-menu items.

HoverBorder:
To change the appearance of border, when the mouse is hovered over sub-menu item.

HoverShadow:
To apply the shadow for the Hover state of the sub-menu item.

Separator:
Separator provides a horizontal or vertical dividing line. It is most commonly used in menus
and tool bars.

Margin:
You can apply margin to sub-menu items according to the requirement.

Padding:
You can apply padding to sub-menu items according to the requirement.

Icons:
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User can place colorful icons in sub menu buttons. Styles of icons can also be customized.

Typography:
Sub menu button text typography.

Add/Edit Menu Item

This option is only available in the case of HTML website design. You can add or edit a menu
item or page using this option.

Bookmark

Menu Bookmark option allow you to save the Menu of the current tempalte for later
use.
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Sidebar Tab

 

Suggest Sidebar

It will suggest you the new design of Sidebar on every
click.

Layout

It provides you  the different placement options for Sidebar. Left Sidebar & Right Sidebar, if
you want to place a single sidebar and Left-Left Sidebar, Right-Right Sidebar & Left-Right
Sidebar, if you want to place double sidebars.

Border

User can also apply the border to sidebar(s).     
More.

Width

You can change the width of the sidebar according to your
requirement.
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Margin

Use this option to apply Margin to the sidebar.

Padding

Use this option to apply Padding to the sidebar.

Color

Choose this option to change the color of Sidebar.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Sidebar.
 
More: 
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Select this option to apply advanced gradient effects.    
More..

Image

Select this option to apply background image to the Sidebar.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the Sidebar.
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More:
Select this option to modify texture settings according to your requirement.    
More..

Effects

Select this option to apply effects on Sidebar.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select this option to apply shadow effect to your Sidebar.
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More:
Select this option to apply custom shadow effect  to the Sidebar.    
More..

100% Height

100%  height itself represent that the height of the sidebar will be equal to the content
height.

Equal to Content

Equal to content means that the height of the sidebar will going to be equal to sidebar's
content (Widgets, Modules etc.).

Bookmark

Sidebar Bookmark option allow you to save the Sidebar of the current tempalte for later
use.
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Modules/Widgets/Block tab

 

Suggest Modules

It will suggest you the new layout of modules/block/widgets on every
click.

Container Properties

Container properties will let you customize the container of modules/block/widgets according
to your theme.
 
Margin :
Use this option to apply Margin around the container.
 
Padding:
Use this option to apply Padding around the container.
 
Border:
Applies the border around the container. You can customize the border from different options
available.
 
Shadow:
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Select this option to apply shadow effect to the container.
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Color

Choose this option to change the color of Container of modules/block/widgets.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Container of modules/block/
widgets.
 
More: 
Select this option to apply advanced gradient effects.     More..
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Image

Select this option to apply background image to the Container of modules/block/widgets.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Header Properties

 
Show Header:
Check the  "Show Header" option to display the header of Module/Widget/Block.
 
Icons:
Icons can also be placed in the header. Icon Color option is also available.
 
Margin:
This option is to apply Margin to the header.
 
Padding:
This option is to apply Padding to the header.
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Heading Type:
TemplateToaster allow you to select desired heading type in Module Header like H1, H2 H3
etc. By using heading types on your page search engines will understand the pages of your
site in a better manner.

Color

Choose this option to change the Background color of Header of modules/block/widgets.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Header of  modules/block/
widgets.
 
More: 
Select this option to apply advanced gradient effects.     More..
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Image

Select this option to apply background image to the  Header of  modules/block/widgets.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the Header of  modules/block/widgets.
 
More:
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Select this option to modify texture settings according to your requirement.    
More..

Effects

Select this option to apply effects on Header of  modules/block/widgets.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect to Header of modules/block/widgets.
 
More:
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Select this option to apply custom shadow effect to the modules/block/widgets.     
More..

Border

This option is to change the styles of Module container border.    
More.

 

Height

This option is used to change the height of header of  modules/block/
widgets.

Typography

Typography of header of modules/block/widgets can be edited from
here.

Content Properties

Module/Content options.
 
Margin:
Use this option to apply the Margin to the content of modules/block/widgets.
 
Padding:
Use this option to apply the Padding to the content of modules/block/widgets.
 
Border:
This option is to display and customize the border around the content of modules/block/
widgets.
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Active Link:
This option is for editing normal link text-styles in the content of modules/block/widgets.
 
Hover Link:
When you rollover the cursor over a link, it is referred as "hover" link. You can change the
text-styles of hover link in the content of modules/block/widgets, using this option.
 
Visited Link:
A link become visited when you click on it one or more time. Change the text-styles of visited
link in the content of modules/block/widgets using this option.
 
Text:
This option is to customize the appearance of the text in the content of modules/block/
widgets.
 
Headings:
Styling of heading(H1, H2 etc) if any in the Module/Block/Widget.
 
Ordered List:
An ordered list can be of Alphabetical or Numerical type.Text-styles of ordered list in the
content of modules/block/widgets can be customized by using this option.
 
Unordered List :
Text-styles of unordered list in the content of modules/block/widgets can be customized by
using this option.
 
Icons:
You can apply icon for unordered list from the pre-designed icons or you can browse the icon
according to your requirement. Icon Color option is also available.

Color

Choose this option to change the color of Content of modules/block/widgets.

No Color:
Select this option to apply transparent background.
 
More Color:    
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Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Content of modules/block/
widgets.
 
More: 
Select this option to apply advanced gradient effects.     More..

Image

Select this option to apply background image to the Content of modules/block/widgets.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Quick Styles

Quick Styles are basically the inbuilt styles of modules/block/widgets. You can apply any of
the pre-designed style.
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Sidebar menu

 

Suggest  Sidebar Menu

It will suggest you new layouts of sidebar menu on every
click.

Container Properties

Container properties will let you customize the Sidebar menu container according to your
requirement.
 
Margin:
Use this option to apply Margin to Sidebar menu container.
 
Padding:
Use this option to apply Padding to Sidebar menu container.
 
Boder:
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It applies the border around the Sidebar menu container. You can customize the border from
different options available.
 
Shadow:
Select this option, to apply shadow effect to Sidebar menu container.

Color

Choose this option to change the background color of Sidebar menu container.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Sidebar menu
container.
 
More: 
Select this option to apply advanced gradient effects.     More..
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Image

Select this option to apply background image to the Sidebar menu container.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Header Properties

 
Show Header:
Check the  "Show Header" option to display header inside the sidebar menu.
 
Icons:
Icons can be placed in the Sidebar menu header. Icon Color option is also available.
 
Margin:
Use this option to apply Margin to Sidebar menu header.
 
Padding:
Use this option to apply Margin to Sidebar menu header.
 
Heading Type:
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This option allow you to select a heading type like H1, H2 etc for the Vertical Menu
header.

Border

This option is for adding/modifying the styles of border of Sidebar menu header.    
More.

Height

This option is used to change the height of Sidebar menu
header.

Typography

Click on this button to change the text-styles of Sidebar menu
header.

Color

Choose this option to change the color of Sidebar menu header.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..
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Gradient

Use this option to apply gradient effect to the Sidebar menu
header.
 
More: 
Select this option to apply advanced gradient effects.     More..

Image

Select this option to apply background image to the Sidebar menu header.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Texture

Use this option to apply texture effect to the header of Sidebar menu.
 
More:
Select this option to modify texture settings according to your requirement.    
More..

Effects

Select this option to apply effects on header of Sidebar menu.
 
More:
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Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect on header of Sidebar menu.
 
More:
Select this option to apply custom shadow effect  to the header of Sidebar menu.     
More..

Menu Button Properties

Separator:
Separator  provides a horizontal or vertical dividing line or empty space. It is most commonly
used in menus and toolbars.         
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Height :
Select this option to increase/decrease the height of the sidebar menu buttons.
 
Width:
Select this option to increase/decrease the width of the sidebar menu buttons.
 
Margin:
Use this option to apply Margin to the sidebar menu buttons.
 
Padding:
Use this option to apply Padding to the sidebar menu buttons.
 
Content Margin:
Use this option to set the Margin of sidebar menu content.
 
Horizontal Alignment:
Use this option to align the sidebar menu buttons horizontally.
 
Icon:
Use this option to place the icon on sidebar menu buttons. Icon color option is also available.
 
Arrow:
If selected Arrows will automatically appear besides the items have sub items. Arrow Color
option is also available.
 
Texture:
Use this option to apply texture to the sidebar menu buttons.

Background

Select this option to choose the background color of sidebar-menu buttons.

Normal:
It is the color of regular sidebar menu button.
 
Hover:
It is the color of the sidebar menu button for its hover state.
 
Active:
Background for the Active menu item.
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Border

Select this option to choose the border of sidebar-menu
buttons.
 
Normal Border:
It is the border of regular sidebar menu button.
 
Hover Border:
It is the border of the sidebar menu button when we hover on it.
 
Active Border:
Border Options for the Active menu item.          More..

Typography

Text-Styles can be changed in sidebar menu buttons.
 
Normal:
It is the text-styles of regular sidebar menu button.
 
Hover:
It is the text-styles of the sidebar menu button when we hover on
it.
 
Active:
Text-styles options for the Active menu item.

 

Expand Horizontally

The sub-menu will expand horizontally when you hover mouse cursor over the parent
item.

Expand Vertically

The sub-menu will expand vertically when you hover mouse cursor over the parent
item.
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SubMenu Container

Submenu is a secondary menu that appears while you hover the cursor over an item on the
primary menu. Users have full control to change the styling of Submenu items.
 
Background :
User can change the background color of Sidebar Menu sub-menu container. Here block in
black color is submenu container.
 
Border:
User can also customize the border of  Sidebar Menu sub-menu container.     More.
 
Shadow:
To apply the shadow effect to the container.

SubMenu Item
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Height:
Select this option to increase/decrease the height of submenu items.    
 
Background:
To change the background color of sub-menu items, use this option.
 
Border:
Use this option to set the border around the sub menu items.          More.
 
HoverBorder:
Select this option, to customize the borderof the Hover state of sub menu items.     More.
 
Shadow:
To apply the shadow to sub menu items.
 
HoverShadow:
Select this option to add/edit the shadow effect to Hover state of the Sub Menu item.
 
Separator:
Separator  provides a horizontal or vertical dividing line or empty space. It is most commonly
used in menus and tool bars.
 
Margin :
Use this option, to apply Margin around sub menu items.
 
Padding:
Use this option, to apply Padding around sub menu items.
 
Icons :
User can place the colorful icons in sub menu buttons. Icon styles can be customized
according to the requirements.
 
Typography:
Sub menu items Typography options.
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Content Tab

 
CMS Content Tab
 
HTML Content Tab
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CMS Content tab

 

Suggest Content

It will suggest you the new designs for the content on every
click.

Content Properties

Content properties will let you customize the appearance of content on your template/theme
or website.
 
Border:
Applies the border around the content. You can customize the border from different options
available.
 
Margin:
Use this option to apply the Margin around the content.
 
Padding:
Use this option to apply the Padding around the content.
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Line-Height:
The line-height property defines the amount of space above and below inline. Use this option
to set the line height.

Color

Choose this option to change the background color of Content area.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Content area.
 
More: 
Select this option to apply advanced gradient effects.    
More..
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Image

Select this option to apply background image to the Content area.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..

Texture

Use this option to apply texture effect to the Content area.
 
More:
Select this option to modify texture settings according to your requirement.    
More..
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Effects

Select this option to apply effects on the Content area.
 
More:
Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect to the Content area.
 
More:
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Select this option to apply custom shadow effect  to the Content area.     
More..

Lists

List are usually the better way to display data. HTML provides us with two type of lists namely
ordered and unordered list. Ordered list is preceeded by numbers, alphabets while unordered
list is preceeded by Bullets, Disc, etc. To format the styles of ordered/unordered list,select this
option.

Typography

Headings:
Select this option , to format the text-styles of headings.
 
Paragraph:
Select this option to format the text-styles of paragraph.
 
Active Link:
This option is for editing normal link text-styles.
 
Hover Link:
When you rollover the cursor over a link, it is referred as "hover" link. Change the text-styles
of hover link using this option.
 
Visited Link:
A link become visited when you click on it, one or more time.  Change the text-styles of visited
link using this option.

Table

 
Tables are beneficial to organize the data in tabular form. It displays data in rows and
columns. To format the styles of table, use this option.
 
Border Type:
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To display the outline of table, select the Border Type option. Border Type option will let you to
change the outline of border i.e. Single or double.
 
Border Style:
Select this option to  change the styles of border. It includes Solid, Dashed or Dotted Lines.
 
Border Thickness:
Select this option to change the thickness of border. Choose the highest value, to display the
thick border.
 
Border Color:
Use this option to select the color for border.
 
Cell Spacing:
Cellspacing creates a space outside table cells. To apply cell spacing, use this option.
 
Typography:
To format the text-styles of table, select this option.    

Post Properties

 
Show MetaData:
The post meta data is the "administrative" information you provide to viewers about each
post. This information usually includes the author of the post, when it was written (or posted),
and how the author categorized that particular post. Here, data in "Blocks" is  called meta
data. Uncheck the 'Show MetaData' option, if you don't want to display.
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Margin:
Use this option to apply Margin around the post.
 
Padding:
Use this option to apply Padding around the post.
 
Inner Border:

Style:
Use this option to apply the inner border on different parts of the post i.e. Title, Metadata &
Both(Title & Metadata).

 
Border:
Use this option to apply border on the element selected from "Style".

 
Shadow:
Use this option to apply shadow on the element selected from "Style".

 
Background:
Use this option to apply background colour to the element selected from "Style".

 
Margin:
Use this option to apply margin to the element selected from "Style".

 
Padding:
Use this option to apply padding to the element selected from "Style".

 
Content Background:
Use this option, to add/change the post content background colour.
 
Content Border:
Select this option to apply/edit border around the post content.
 
Content Margin:
Select this option to apply margin around the post content.
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Content Padding:
Select this option to apply padding around the post content.
 
Heading Type:
TemplateToaster wllo you to select desired heading type for the post header like H1, H2 etc.
 
Featured Post:
Use this option to select the number of post which is to be displayed as Featured( for
Wordpress only) [Full width post].
 
Columns:
Use this option to select the number of Columns in which you want to display the posts( for
Wordpress only).

Color

Choose this option to change the background color of Post.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..
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Gradient

Use this option to apply gradient effect to post.
 
More: 
Select this option to apply advanced gradient effects.    
More..

 

Image

Select this option to apply background image to post.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Shadow

Select the option to apply shadow effect to the post.
 
More:
Select this option to apply custom shadow effect  to the post.     
More..

Texture

Use this option to apply texture effect to the post.
 
More:
Select this option to modify texture settings according to your requirement.    
More..
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Effects

Select this option to apply effects to the post.
 
More:
Select this option to modify transparency setting according to your requirement.    
More...

Border

To apply the border around the post.         
More..

Typography

 
Headline:
Use this option to change the typography of post headline.
 
Headline Hover:
Use this option to change the typography of post headline hover state.
 
Metadata:
Metadata typography option.
 
MetaLink:
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Metadata links typography option.
 
MetaLink Hover:
Metadata links hover state typography option.
 
Content:
Click on this option to change the text-styles(typography) of post
content.

Icons

Select this option to apply icons on various elements of post.
 
Post Headline:
To place the icon on Post Headline. You can choose either from the predesigned icons or you
can upload icon according to the requirement by using Browse button. You can customize the
color of icon using Color option.

 
Author:
Option to place the icon of author in post. You can choose either from the predesigned
icons or you can upload icon according to the requirement by using Browse button. You can
customize the color of icon using Color option.

 
Date:
Option to place the icon of date in post. You can choose either from the predesigned icons
or you can upload icon according to the requirement by using Browse button. You can
customize the color of icon using Color option.
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Print:
Option to place the print icon in post. You can choose either from the predesigned icons
or you can upload icon according to the requirement by using Browse button. You can
customize the color of icon using Color option.

PDF:
Option to place the icon of PDF in post. You can choose either from the predesigned icons
or you can upload icon according to the requirement by using Browse button. You can
customize the color of icon using Color option.

 
Email:
Option to place the icon of e-mail in post. You can choose either from the predesigned
icons or you can upload icon according to the requirement by using Browse button. You can
customize the color of icon using Color option.
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Comment Properties

Border:
Option to apply or edit border around the comment box.
 
Margin:
Option to apply or edit margin around the comment box.
 
Padding:
Option to apply/edit padding around the comment box.
 
Shadow:
Option to apply/edit shadow effect to comment box.
 
Typography:
Select this option to change the text-styles(typography) of comment box (for Wordpress and
Drupal).

Color

This option is to change the background color of comment box.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..
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Gradient

Use this option to apply gradient effect to the comment box.
 
More: 

            Select this option to apply advanced gradient effects.     More..

Image

Select this option to apply background image to the comment box.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Quick  Styles

Quick Styles are basically the pre-defined styles of post . To apply the Quick Styles you can
choose any of the various options available.

Bookmark

Content Bookmark option allow you to save the Content design of the current tempalte for
later use.
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HTML Content Tab

 

Suggest Content

It will suggest you the new layout of content on every
click.

Color

This option to change the background color of Content area.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..
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Gradient

Use this option to apply gradient effect to the Content area.
 
More: 
Select this option to apply advanced gradient effects.    
More..

Image

Select this option to apply background image to the Content area.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Border

Use this option to apply the border around the content
area.

Margin

Use this option to apply the Margin around the content
area.

Padding

Use this option to apply the Padding around the content
area.

Columns

Add & Remove Columns : Add button (+) will generate the number of rows  as many as you
want. Remove button (-) will delete the selected rows one by one.

Columns :  You can use this option to specify the number of columns in a row.

Color

Use this option to apply the background color to a row in Content area. Select the row for which
you want to apply the background color and then choose the color for the selected row.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.     More..
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Gradient

Use this option to apply the gradient effect to a row in Content area. Select the row for which
you want to apply the gradient effect and then choose the gradient effect for the selected row.
 
More: 
Select this option to apply advanced gradient effects.     More..

Image

Use this option to apply the background image to a row in Content area. Select the row for
which you want to apply the background image and then choose the background image for the
selected row.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Border

Use this option to apply  the border to a row in Content area. Select the row for which you want
to apply the border and then apply the border for the selected row.

Margin

Use this option to apply the margin to a row in Content area. Select the row for which you want
to apply the margin and then apply the margin for the selected row.

Padding

Use this option to apply the padding to a row in Content area. Select the row for which you want
to apply the padding and then apply the padding for the selected row.

Border

Use this option to apply the border to a column in Content area. Select the column for which
you want to apply the border and then apply the border for the selected column.

Width

Use this option to apply the width to a cell in Content area. Select the cell for which you want to
apply the width and then apply the width for the selected cell.

Margin

Use this option to apply the margin to a cell in Content area. Select the cell for which you want
to apply the margin and then apply the margin for the selected cell.

Padding

Use this option to apply the padding to a cell in Content area. Select the cell for which you want
to apply the padding and then apply the padding for the selected cell.
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Color

Choose this option to change the background color of cell of Content area.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the cell of Content
area.
 
More: 
Select this option to apply advanced gradient effects.     More..
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Image

Select this option to apply background image to the cell of Content area.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More..
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Module Position/ Widget Areas/ Regions

 

Add Columns & Rows

Add & Remove buttons : Add button (+) will generate the number of position bars as many as
you want. Select the row where you want to add the new position bar and then click on the  Add
button(+).  Remove button (-) will delete the selected position bars one by one.

Columns :  You can use this option to specify the number of Module-Positions/Widget-Areas/
Regions in a position row/bar.

Color

Use this option to apply the background color to a position bar. Select the position bar for which
you want to apply the color and then choose the color for the selected position bar.

No Color:
Select this option to apply transparent background.
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More Color:    
Select this option to use wide range of color collection available in Color Picker.     More..
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Gradient

Use this option to apply the gradient effect to the background of a position bar. Select the position
bar for which you want to apply the color and then choose the color for the selected position bar.
 
More: 
Select this option to apply advanced gradient effects.     More..

Image

Use this option to apply the background image to a Position bar. Select the position bar for
which you want to apply the background image and then choose the background image for the
selected position bar.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More...
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Border

Use this option to apply the border to a position bar. Select the position bar for which you want
to apply the border and then apply the border for the selected position bar.     More..

Margin

Use this option to apply the Margin to a position bar. Select the position bar for which you want
to apply the Margin and then apply the margin for the selected position bar.

Padding

Use this option to apply the padding to a position bar. Select the position bar for which you
want to apply the padding and then apply the padding for the selected position bar.

Color

Use this option to apply the background color to an individual positions. Select the position cell
for which you want to apply the color and then choose the color for the selected position cell.

No Color:
Select this option to apply transparent background.
 
More Color:    
Select this option to use wide range of color collection available in Color Picker.     More..
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Gradient

Use this option to apply the gradient effect to the background of an position cell. Select the
position cell for which you want to apply the gradient effect and then choose the gradient effect
for the selected position cell.
           
More: 
Select this option to apply advanced gradient effects.     More..

 

Image

Use this option to apply the background image to a position. Select the position cell for which
you want to apply the image and then choose the image for the selected position cell.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More...
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Border

Use this option to apply the border to a position. Select the position cell for which you want to
apply the border and then apply the border for the selected position cell.     More..

Margin

Use this option to apply the margin to a position. Select the position for which you want to apply
the margin and then apply the margin for the selected position cell.

Padding

Use this option to apply  the padding to a position. Select the position for which you want to
apply the padding and then apply the padding for the selected position cell.

Width

Use this option to apply  the width to a position. Select the position for which you want to apply
the width and then apply the width for the selected position cell.

Show in Mobile View

Use this option to show/hide a position in mobile. Select the position which you want to show/
hide in mobile and then check the option to show the cell in mobile and vice versa to hide.

Module Name

Use this option to rename a position. Select the position which you want to rename and then
write down the desired name in the text box and click ok button.
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Draw Position

 
Use this option to draw a position on header/menu/footer.
 
Color:

Use this option to apply the background color to a drawn position. Select the drawn
position for which you want to apply the color and then choose the color for the selected
drawn position.

No Color:
Select this option to apply transparent background.

 
More Color:    
Select this option to use wide range of color collection available in Color Picker.    
More..

 
Gradient:

Use this option to apply the gradient effect to the background of a drawn position. Select
the drawn position for which you want to apply the gradient effect and then choose the
gradient effect for the selected drawn position.

           
More: 
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Select this option to apply advanced gradient effects.     More..
 
 

Image:

Use this option to apply the background image to a drawn position. Select the drawn
position for which you want to apply the image and then choose the image for the
selected drawn position.

 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More...

 
Draw:
Click on this Draw Button and now you can draw a new position on Header, Menu or Footer.
  After click the mouse pointer will change into a crosshair pointer and then you can draw
position on header, menu or footer according to your requirement.
 
Border :
Use this option to apply the border to a drawn position. Select the drawn position for which you
want to apply the border and then apply the border for the selected drawn position.
 
Draw Position Name :
Use this option to name/rename a drawn position. Select the drawn position which you want to
provide a name and then write down the desired name in the text box and click ok button.
 
Show in Mobile View:
Use this option to show/hide a drawn position in mobile. Select the drawn position which you
want to show/hide in mobile and then check the option to show the position in mobile and vice
versa to hide.
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Element Tab

 

Suggest Elements

Using this button TemplateToaster will suggest you the new design for all the controls, on
every click.

Button

 
Background:
Use this option to change the background of buttons.

Border:
Use this option to set the border around the  buttons.

Typography:
Select this option to change the text-styles of buttons.

Effects:
Use this option to change the display of buttons by using texture and shadow effects on buttons.

Padding:
Use this option to apply the padding to the buttons.
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Text Box

 
Background:
Use this option to change the background of textbox.

Border:
Select this option to set border around textbox.

Typography:
Use this option to change the text-styles of textbox.

Pagination

 
Background:
Use this option to change the background of pagination.
 
Border:
Select this option to set border around pagination.
 
Typography:
Use this option to change the text-styles of pagination.
 
Margin:
Use this option to set the margin around pagination.
 
Padding:
Use this option to set the margin around pagination.
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Breadcrumb

 
Background:
Click on this option, to change the background of
breadcrumbs.
 
Border:
Select this option, to set the border around the breadcrumbs.
 
Typography:
Use this option to change the text-styles of pagination.

Block Quote

 
Typography:
Use this option to change the text-styles of Blockquote.

Border:
Select this option, to apply the border around the Blockquote.

Icons:
Use this option  to customize the styles of Blockquote icons.

Background:
Click on this option, to change the background of Blockquote.
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Margin:
Use this option to set the margin around Blockquote.

Padding:
Use this option to set the padding around Blockquote.

Checkbox

Is Default:
Check the 'Is Default' option to use the default style of the checkbox.

 

Style:
Use this option to select the style of a checkbox(checkbox with a check or checkbox with a
fill).
 
Outer Border:
Select this option to change the outer border around checkbox.
 
Inner Fill:
Select this option to change the color of Check/Fill.
 
Outer Fill:
Select this option to fill the color inside the checkbox.

Radio Button

Is Default:
Check the 'Is Default' option to use the default styles of the radio
button.
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Outer Border:
Select this option to change the outer border of radio button.
 
Inner Fill:
Select this option to change the color of  bullet inside radio button.
 
Outer Fill:
Select this option  to fill the color inside the radio button.
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Footer Tab

 

Suggest Footer

It will suggest you the new design for Template Footer on every
click.

Layout

No Footer:
Select this option to remove the footer from your
design.
 
Footer:
Select this option to display the footer in your design.

Border

Select this option to apply border around the footer. You can customize the styles of border by
using this option.     More..
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Height

It will let you to set the height of the footer. Click on "more option" to specify your required
footer height.

Margin

Use this option to apply margin to the
footer.

Width

Full width:
This option is to set the width of footer equal to brower's width.
 
Equal to Page Width:
Select this option to set the footer width equal to your page
width.
 
CustomWidth:
Configure  the footer width with custom values.

Color

Use this option to apply the background color to Footer.

No Color:
Select this option to apply transparent background to the footer.
 
More Color:    
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Select this option to use wide range of color collection available in Color Picker.    
More..

Gradient

Use this option to apply gradient effect to the Footer.
 
More: 
Select this option to apply advanced gradient effects.    
More..

Image

Select this option to apply background image to the Footer.
 
More: 
Select this option to Browse an image and modify image settings according to your
requirement.     More...
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Texture

Use this option to apply texture effect to the Footer.
 
More:
Select this option to modify texture settings according to your requirement.    
More..

Effects

Select this option to apply effects on  Footer.
 
More:



 

119  | TemplateToaster

Select this option to modify transparency setting according to your requirement.    
More..

Shadow

Select the option to apply shadow effect to the Footer.
 
More:
Select this option to apply custom shadow effect  to the Footer.     
More..

Foreground Image

Foreground image option for the footer.    
More..

Text Areas

Text Areas is another convenient option to place the text in footer.Use this option to draw text
area in footer. After adding double click on Text Area box, to edit the text. Text formatting can
also be done.

Background

                Select this option to apply the background to TextArea on footer.
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Effects

This option to apply effects in TextArea.
 

 
More..

 

More..
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More..

Border

To apply border on TextArea. You can also personalize the styles of border, with this option.   
  More..

Headings

Heading(H1, H2 etc.) styles configuration that will appear in the footer.

Copyright

You can customize the copyright styles in your template/theme/website from this
option.
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Designed By

It is a common practice  to represent the name of the website designer. Using this option, you
can customize the styles of "Website Designed with" element.
 
By default TemplateToaster add "Designed with TemplateToaster", you can edit/remove it from
File-> Preferences.

Text

              Select this option to personalize the text-styles of any plain text of the footer.

Lists

Lists are usually the better way to display data in bullets. HTML provides us with ordered and
unordered list, to display data. Ordered list is preceeded by numbers, alphabets while unordered
list is preceeded by bullets, disc, etc. To format the styles of ordered/unordered list,select this
option.

Links

Active Link:
This option is for editing normal link typography.
 
Hover Link:
When you rollover the cursor over a link, it is referred as "hover" link. Change the text-styles
of hover link using this option.
 
Visited Link:
A link become visited when you click on it, one or more time.  Change the text-styles of visited
link using this option.

Separator:
Separator  provides a horizontal or vertical dividing line or empty space. It is most commonly
used in menus and tool bars.
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Social Media Icons

Social media network will let you to connect with the world. Social networking websites are
used for interaction among people in which they create, share, and/or exchange information
and ideas in virtual communities and networks.Here, we provide you the option to place some
popular social media icons , to connect your website with your social network.
You can place any of the pre-designed icons or you can browse the desired icon by clicking
on More button.
In the Link field, you can input the URL/link of your social media page.

Bookmark

Footer Bookmark option allow you to save the Footer of the current tempalte for later
use.
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Responsive Tab

 

Responsive Layout

Responsive Web Design (RWD) is a Web design approach aimed at crafting sites to provide
an optimal viewing experience—easy reading and navigation with a minimum of resizing,
panning, and scrolling—across a wide range of devices (from mobile phones to desktop
computer monitors).
 
Check/Tick this checkbox to enable Responsive Web Design (RWD) in you template/theme or
website.

Mobile

Click on this button to preview your design in Mobile
view.

MiniTab

Click on this button to preview your design in Minitab
view.

Tab

Click on this button to preview your design in Tab
view.



 

125  | TemplateToaster

Desktop

Click on this button to preview your design in Desktop
view.

Custom

Just fill the desired Height/Width, click ok and TemplateToaster will show your template in
your custom dimentions viewport.
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Editor Tab

 

Undo/Redo Controls

These are the editing commands. Undo(CTRL+z) reverses the most recent editing command.
For example, this can be used to restore unintentionally deleted text. Redo (CTRL+y) can
restore the changes again. For example, if some text was inserted, Undo will remove it. Redo
will insert it again.

Fonts

Select the text and use this option to customize text-styles.

Text Alignment

Text alignment determines the appearance and orientation of a block of text. Text can be left-
aligned which means text will begin at each line along the left margin of the document, right-
aligned which aligns the beginning of each line of text along the right margin of the document,
center-aligned  which place the text at the center of each line or justified which means it is
aligned evenly along the left and right margins.

Unordered List

List is usually the better way to display data in bullets. Unordered list is preceeded by bullets,
disc, etc. To use unordered list, select the text and then click on this button.
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Ordered List

Ordered list is preceeded by numbers, alphabets. To use ordered list, select the text and then
click on this button.

Paragraph Margin from Top

To apply margin to paragraph from top, select the paragraph where you want to apply the
margin and then select the desired margin.

Paragraph Margin from Bottom

To apply margin to paragraph from bottom, select the paragraph where you want to apply the
margin and then select the desired margin.

Left/Right Indentation

Indentation determines the distance of the paragraph either from the left or the right
margin.The indent tool controls the starting point for all lines of the paragraph. Select the text
and click on this left/right indent button to indent the text either on Left side or on Right side.

Line Height

The line-height property is used to apply the spacing between the lines of text. Select the text
to which you want to apply line height.

Draw Outline

You can use this option to draw a horizontal line. Place the cursor where you want to draw the
line and then click on this button. You can also customise the appearance of the line.

Image

Click on this option to insert an image in content box. Place the cursor where you want to
insert the image and then click on this button.
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Button

Click on this option to insert the button in your document. Place the cursor where you want
to insert the button and then click on this button. You can personalize the button according to
your design.
 
You can customize the appearance of this button under Elements tab-> Button

Hyperlink

It is a link that redirect to another link or a document or web page. Select some text, click the
Hyperlink button and enter the valid url, to place the hyperlink on that selected text.

Table

To insert the table in your document, place the cursor where you want to insert the table and
then click on this button. Specify the number of rows,columns,column width,border thickness
and color and then click on OK button .
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Delete Table

To delete the table, place the cursor on the table and click on delete table
button.

Insert Row Above

Click on a cell, above which you want to add a row. Place the cursor, where you want to insert
the row above the cell and click on the insert row above button.

Insert Row Below

Place the cursor on the row below which you want to add a row and then click on the insert
row below button.

Remove Row

To remove the row from the table, place the cursor on the row which is to be deleted, and
then click on remove row button.

Insert Column Left

To insert a column to the left of a particular column, place the cursor on that column, and click
on Insert Column Left button.

Insert Column Right

To insert a column to the right of a particular column, place the cursor on that column, and
click on Insert Column Right button.
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Remove Column

To remove a column, place the cursor on the column which is to be deleted and click on
Remove Column button.
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Dialog Boxes

 
In TemplateToaster a dialog box(or dialogue box) is a window
having more options common to a specific type of elements
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Choosing colors

 

 

Dropper

It can be used for picking color from any desired
location.

ScRGB

ScA:
It is used to set ScRGB alpha channel value of the color.
The alpha channel of a Color structure determines the amount of transparency the
Color has. An alpha value of 1 indicates the Color is completely opaque and a value of
0 indicates the color is completely transparent.
 
ScR:
It is used to set ScRGB red channel value of the color.
 
ScG:
It is used to set ScRGB green channel value of the color.
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ScB:
It is used to set ScRGB blue channel value of the color.

sRGB

It stands for "Standard RGB" (and RGB stands for Red-Green-Blue"). All the colors
you see on your computer display are made up of various mixtures of red, green, and
blue colors.
 

Hexadecimal

Using this option, you can input any valid hexadecimal value of
color.
 

Transparency

You can set the transparency for the color according to your
requirement.
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Gradient Fill

 

 
The Gradient tool creates a gradual blend between multiple colors. You can choose from
preset gradient fills or create your own.
 
Linear gradient shades are in a straight line from the starting point to the end point .
 
Radial gradient shades are in  a circular pattern from the starting point to the end point.
 
Angle is used to provide the angle between the two colors.
 
Color is used to provide the second color apart from background color to form a gradient.
 
Offset is used to set the location of the color stops.
 
How to add more Gradient Stops: Just click anywhere on the above shown gradient strip and
TemplateToaster will add a new Gradient Stop now you can use the color selector to add new
color to that Gradient Stop. There is no limit you can add as many gradient stops as you want.
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Image

 

Image option

Select this radio button to insert the
images.

Repeat

Repeat-X:
It'll repeat the image in the direction of X-axis.
 
Repeat-Y:
It'll repeat the image in the direction of Y-axis.

Stretch

 
None:    
The content will preserve its original size.
 
Fill: 
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The image is resized to fill the destination dimensions. The aspect ratio is not preserved.
 
Uniform:
The image is resized to fit in the destination dimensions while preserving its native aspect
ratio.
 
Uniform to Fill:
The content is resized to fill the destination dimensions while preserving its native aspect
ratio. If the aspect ratio of the destination rectangle differs from the source, the source content
is clipped to fit in the destination dimensions.

Horizontal Alignment

Left will align the background image to left side.
 
Center will align the background image to the center.
 
Right will align the background image to the right
side.

Vertical Alignment

 
Top will align the image to the top.
 
Center will align the image to the center.
 
Bottom will align the image to the bottom.

Transparency

You can add the transparency effect to the  image.
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Texture

 

 
Texture provide you the option to add texture to the background. To try different textures,
hover your mouse pointer on different textures, and then select the best suited texture for your
background.

Navigation Control
 

This navigation control helps you to navigate among the different controls.
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Special Effect

 

 
You can use this option to apply different type of special effect on background. To preview
different special effects, hover your mouse cursor on different special effects, and select the
best suited special effect for your background.
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Shadow

 

 
To apply shadow effect, select the shadow from listed shadow effects or you can personalize
the features of shadow by using color, blur, angle and distance.

Blur is used to apply blur effect to the shadow. As the value of the blur increases, the shadow
will get more and more blurry. You can use the slider or numeric up down to change the value
of the blur.

Angle is used to set an angle between the element and the shadow. You can use the slider or
numeric up down to change the value of the angle.

Distance  changes the apparent distance between the element and the shadow. You can use
the slider or numeric up down to change the value of the distance.
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Foreground Images

 

Foreground images are  used to enhance the center of interest by showing how it fit into its
environment. Either select the foreground images from pre-designed images or Click on Browse
button to add an image according to your requirement.

Flip

Flip X:
It allows you to rotate the picture in direction of X-axis.

Flip Y:
It allows you to rotate the picture in direction of Y-axis.

Selecting both the option, will flip the image simultaneously towards X and Y axis.
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Link

User can also insert the link on foreground image. Insert the link in text area and click on Apply
button.

Transparency

You can add the transparency effect to the 
image.

Logo

Click on logo tab to choose the logo for header.

Layout

Select this option to change the header layout.
 
Height:
Select the desired value from numeric up down to change the header
height.
 
Width:
Select the desired type from drop down to change the header width.
 
Margin:
This option will let you to set the margin around the header.

 

Slide Show

You can customise the slideshow transition duration and
more.
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Border

 

 
Border can be applied on any element, for example as a decorative element or to underline a
separation of two things. CSS gives you endless options while using border in your pages.

Border Style

The border-style sets the appearance of the border on all four sides of an element using the
value specified. It can be Dashed, Dotted or Solid.

Border Thickness

Border Left:
It is used to apply the border on the left side of the element. Select the desired value for
thickness, from the numeric up down, to apply the border from left side.
 
Border Right:
It is used to apply the border on the right side of the element. Select the desired value for
thickness, from the numeric up down, to apply the border from right side.
 
Border Top:
It is used to apply the border on the top side of the element. Select the desired value for
thickness, from the numeric up down, to apply the border from top side.
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Border Bottom:
It is used to apply the border on the bottom side of the element. Select the desired value for
thickness, from the numeric up down, to apply the border from bottom side.

Border-Radius

Top-Left:
Top-Left radius is used to denote the radius of top-left corner. The curve of radius also
increases as the pixels of top-left radius increases.
 
Top-Right:
Top-Right radius is used to denote the radius of top-right corner. The curve of radius also
increases as the pixels of top-right radius increases.
 
Bottom-Left:
Bottom-Left radius is used to denote the radius of bottom-left corner.The curve of radius also
increases as the pixels of bottom-left radius increases.
 
Bottom-Right:
Bottom-Right radius is used to denote the radius of bottom-right corner.The curve of radius
also increases as the pixels of bottom-right radius increases.
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File Menu

 

Save

You can use the Save and Save As commands to store your project on your computer as .ttr
project file for future modification. You should save the file frequently while you are working
on it to avoid losing data because of an unexpected power failure or other problem. Use
keyboard shortcut  (Crtl+s)  to save your project.
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Save As

You can use the Save As command to save your project with another
name.

Open

To open an exisitng project file(.ttr) use this option, else you can use (Ctrl+o) keyboard
shortcut to open a file.

Export

Export option is to export the template/theme to install on your CMS(like Joomla Wordpress
etc.). User can export any template/theme/website type into Zip file or in folder.
 
Template/Theme or Website if exported while using the TemplateToaster in trial mode will
have watermarkesall over it.

New

To start with new project, use (Ctrl+n) or the New option from
menu.

Preview

To preview your template/theme/website in browser, use (Ctrl+p)  as a keyboard shortcut or
select Preview command.

Preview RTL

To preview your template/theme/website in RTL format(for Right to Left languages like
arabic).
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Preference

  
 
Applications Settings :
  - Select Your Language

Choose the language in which your are comfortable to work in TemplateToaster.
- Show export information dialog

Check this option if you want to view the installation instruction of template/theme/
website type after every export. This is optional.

- Use hardware graphics acceleration if available
Uncheck this option if your application is running too slow. This could be due to bad
graphics drivers.
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Proxy Settings :
- Select Your Proxy Type :
Select the proxy type to configure the setting of FTP and internet connection.  Proxy type
setting is an optional requirement.
 
Page Width:
Set the maximum and minimum page width of your template/theme/website.This option will
works only when you are working with Fluidic designs.
 
Edition:
It displays the type of TemplateToaster Edition you choose at the time of Installation. Standard
Edition allows you to create templates. But some productivity boost features are locked in the
Standard Edition mode.
 
Professional Edition enables advanced functions that boost productivity when working with large
and complex websites. By using the Professional Edition you will be able to use all the features
of TemplateToaster.

CSS Prefix:
This option add desired css prefix to every class and ID of the exported template/theme/site.
 
Author name:
Edit the name of author to include your name.

Author URL:
It is useful to display the homepage url of theme author(used in Wordpress).

License:
This option is for Wordpress themes. Using this option you can provide the license for your theme.

License Uri:
This option is for Wordpress themes. It is used to provide Uniform Resource Identifier(URI) for
the license.

Theme Uri:
This option is for Wordpress themes. Theme URI, if used, is required to link to a page specifically
related to the Theme. If a demonstration site or page is being used, the content must be related
to the theme itself. Use this option to provide Theme Uri for your users.

Theme Version:
You can provide the version of your theme.

Meta Description/ Meta Keywords:
Meta description is HTML attributes that provide concise explanation of the content of web pages.
Meta description is commonly used on search engine result pages (SERPs) to display preview
snippets for a given page.

Title:
Edit the text and enter the title of your website that you want to display on browser.

Footer Links:
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Insert the link that you want to display in your website footer.

Content Image:
This option is useful in case you want to display the image in post. Browse the image from your
location and click on button Apply.

Custom Css:
Add your own custom CSS that you want to include in the exported theme/tempalte/website.

HeadScript:
This option is useful for inserting the script in the header part of the tempalte. For example you
can add Google tracking code using this option.

Favicons:
Favicons ar also known as shortcut icon, Website icon , URL icon or bookmark icons. Select the
favicons from gallery or browse the icon by clicking on More button according to your requirement.

FTP

FTP(File Transfer Protocol) is used to upload your theme/template or website to your hosting
server.

Help

Help option will redirect you to the online tutorial of Wordpress, Joomla , Drupal, etc. Use
Contact Support to write any queries/suggestion regarding TemplateToaster.

Activation

Enter the activation key in input field to activate the
software.

Updates

Update option will  show you the latest updates of
software.
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Upload your CMS Template

 
Wordpress Theme Installation
 
Joomla Template Installation
 
Drupal Theme Installation
 
Magento Template  Installation
 
E107 Template Installation
 
HTML Website Installation
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Wordpress

 

 
Folder/ Zip:
To export the theme as folder or zip, select desired option.
 
RTL:
To make your theme design RTL(for Right to Left languages like Arabic), select this check
box.
 
WooCommerce Compatible:
To make your theme compatible with WooCommerce plugin of Wordpress, select this check
box.
 
File Name:
Desired name of your theme.
 
Path:
Browse the path where you want to export your theme, by clicking on Browse button.
 
Export:
Click on this button to export the theme.
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Installation
 
 

Upload

After Logging in, go to Appearance >Themes. Select Upload to install the
theme.

Browse

Browse the theme by clicking on Browse button and then click on Install Now button to install
the theme. After installing the theme, click on Activate to activate the installed theme.
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Theme Options

 

 

Theme Options

Go to "Theme Options",   and configure the various options to customize the wordpress
theme

Header

Display Site Title :
Select the On option, if you wish to display the Site Title, otherwise keep it Off to hide the Site
Title.
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Title Font Size:
Enter the desired font size of Site Title.
 
Heading Tag for Title:
Select the Heading tag(like H1, H2 etc.) for Site Title.  By using such headings on your page,
search engines will understand the pages of your site in a better manner. This will help to
boost your ranking in the SERP(Search Engine Results Page).
 
Display Site Slogan :
Select the On option, if you wish to display the Site Slogan, otherwise keep it Off to hide the
Site Slogan.
 
Slogan Font Size:
Enter the required font size for Site Slogan.
 
Heading Tag for Slogan:
Select the Heading tag(like H1, H2 etc.) for Site slogan.  By using such headings on your
page, search engines will understand the pages of your site in a better manner. This will help
to boost your ranking in the SERP(Search Engine Results Page).

Post / Content

 

 
Number of Featured Posts :
Select the number of post(s ) that is to be displayed as featured(full width) on your blog page.
 
Number of Columns:
Enter the required number of columns to display the remaining posts, apart from featured
post(s), on your blog page.
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Breadcrumbs:
Breadcrumbs  is basically the type of text-based web site navigation that breaks the site into
links of categories and sub-categories allowing major categories of information to be linked
in a sequential order. Breadcrumb navigation is displayed to the user, so that they can easily
navigate between the pages.
Select the On option, if you wish to display the Breadcrumbs, otherwise keep it Off to hide the
Breadcrumbs.
 
Breadcrumbs Text Seperator :
Breadcrumbs Text Seperator is used to seperate the text from one link to another. User can
place relevant seperators to seperate the breadcrumbs.

 
Featured Image Width:
To set the Featured Image Width in post(s).
 
Featured Image Height:
To set the Featured Image Height in post(s).

Sidebar

 

 
Use Vertical menu on Sidebar-1 :
  Select On to display the Vertical Menu on Sidebar1, otherwise keep it Off to hide the Vertical
Menu on Sidebar1.
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Use Vertical menu on Sidebar-2 :
Select On to display the Vertical Menu on Sidebar2, otherwise keep it Off to hide the Vertical
Menu on Sidebar2.
 
Sidebarmenu Heading Font size:
Enter the desired font size for Sidebarmenu Heading.
 
Heading Tag for Sidebarmenu Heading :
Select the Heading tag(like H1, H2 etc.) for Sidebarmenu Heading. By using such headings
on your page, search engines will understand the pages of your site in a better manner. This
will help to boost your ranking in the SERP(Search Engine Results Page).
 
Block Heading Font size :
Enter the desired font size for Block Heading.
 
Heading Tag for Block Heading:
Select the Heading tag(like H1, H2 etc.) for Block Heading. By using such headings on your
page, search engines will understand the pages of your site in a better manner. This will help
to boost your ranking in the SERP(Search Engine Results Page).
 

Footer
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Footer Copyright Text :
Option to add/edit Copyright Text in footer
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Footer Copyright URL :
Place the relevant copyright URL on Copyright Text in  footer.
 
Display Footer Copyright :
Select On to display the Copyright Text in footer, otherwise keep it Off to hide the Copyright
Text.
 
Footer Copyright Font Size :
Enter the required font size for Footer Copyright Text.
 
Footer Designed by Font Size:
Enter the required font size for Designed by element in footer.
 
Footer Designed by Link Font Size:
Enter the required font size for Designed by Link Text.

 
RSS icon :
Upload the desired RSS icon on footer.
 
Display RSS icon:
Select On to display the  RSS icon, otherwise keep it Off to hide the  RSS icon.
 
Facebook Icon:
Upload the desired Facebook icon on footer.
 
Display Facebook Icon:
Select On to display the  Facebook icon, otherwise keep it Off to hide the  Facebook icon.
 
Facebook  Icon URL:
Option to provide URL for Facebook icon.
 
LinkedIn Icon:
Upload the desired LinkedIn icon on footer.
 
Display LinkedIn Icon:
Select On to display the  LinkedIn icon, otherwise keep it Off to hide the  LinkedIn icon.
 
LinkedIn  Icon URL:
Option to provide URL for LinkedIn icon.
 
Twitter Icon:
Upload the desired Twitter icon on footer.
 
Display Twitter Icon:
Select On to display the  Twitter icon, otherwise keep it Off to hide the Twitter icon.
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Twitter Icon URL:
Option to provide URL for Twitter icon.
 
GooglePlus Icon:
Upload the desired GooglePlus icon on footer.
 
Display GooglePlus Icon:
Select On to display the  GooglePlus icon, otherwise keep it Off to hide the GooglePlus icon.
 
GooglePlus  Icon URL:
Option to provide URL for GooglePlus icon.

Color

 

 
Best color combination makes the website more attractive and professional.  Select the
colors, to customize the various parts of your website.
 
Site Title Color :
For choosing the color of Site Title.
 
Site Slogan Color:
For choosing the color of Site Slogan.
 
Block Heading Color:
For choosing the color of Block Heading.
 
Sidebar Menu Heading Color:
For choosing the color of Sidebar Menu Heading.
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Footer Copyright Color:
For choosing the color of Footer Copyright Text.
 
Footer Designed By Color:
For choosing the color of Footer Designed By Text.
 
Footer Designed by Link Color:
For choosing the color of Designed by Link Text.
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Shortcodes

 

 
Shortcodes have been introduced for creating macros to be used in a post/page content.
Simply place a shortcode in a post/page content to see the effects.
 
Google Docs Viewer :
Google Docs is used to view documents online quickly without leaving your browser. This is
the shortcode for placing the Google Docs Viewer in the page/post.
 
Displaying related Post:
Shortcode to display the posts related to the post in which shortcode is placed.
 
GoogleAd sense :
Google AdSense is a program run by Google that allows publishers in the Google Network of
content sites to serve automatic text, image, video, or interactive media advertisements that
are targeted to site content and audience. These advertisements are administered, sorted,
and maintained by Google. This is the shortcode for placing the GoogleAd sense in the page/
post.
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Google Chart:
Google Chart provides a perfect way to visualize data on your website. This is the shortcode
for placing the Google Chart in the page/post.
 
Tweet Me Button:
Twitter is an online social networking and microblogging service that enables users to send
and read "tweets". This is the shortcode for placing the Tweet Me Button in the page/post.
 
Google Map:
Google Map is a web mapping service application and technology provided by Google. This
is the shortcode for placing the Google Map in the page/post.
 
YouTube:
YouTube is a video-sharing website owned by Google. This is the shortcode for embedding a
video inside the page/post.
 
Private Content:
Shortcode to display the selected content to the registered users only, in a post/page.
 
PayPal:
Shortcode to display the PayPal button in a post/page.
 
ContactUs Form:
Shortcode to display the ContactUs Form in a post/page.
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ContactUs Form

 

 
Admin Email Address:
This is the option to provide the e-mail address where you want to get all the mails generated
from contact us form.

 
Field Name:
It is the name of the field of the contact us form.

 
Required:
Using this option, you can set a field whether  it is compulsory or not  to fill the field before
submitting the contact us form.

 
Remove:
You can remove any field any time by clicking on this button.

 
Add New Field:
By clicking on this button, you can add custom fields according to your requirement to your
contact us form.
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General

 
Google Analytics:
Google Analytics is a service offered by Google that generates detailed statistics about a
website's traffic and traffic sources and measures conversions and sales. It is for inserting
Google Analytics code to your website.
 
Display All Page Titles:
Using this option, you can turn on or off all the page titles on your website.
 
Display All Post Titles:
Using this option, you can turn on or off all the post titles on your website.
 
Display Post Date:
Using this option, you can turn on or off the date on which the post is published.
 
Display Author Name:
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Using this option, you can turn on or off the author name of the post.
 
Show Post Category:
Using this option, you can turn on or off the category in which the post is published.
 
Display Post Navigation:
Using this option, you can turn on or off the Post Navigation text written over the posts.
 
Display Older/Newer Post Links:
Using this option, you can turn on or off the Older/Newer Post Links written below the Post
Navigation.
 
Display Pagination Links of Post Pages:
Using this option, you can turn on or off the Pagination Links in place of Older/Newer Post
Links below the Post Navigation.
 
Display 'Comment are closed' Text:
Using this option, you can turn on or off the 'Comment are closed' text.
 
Display Back To Top Button:
Using this option, you can turn on or off the Back To Top button which is for going to top from
the bottom of the page.
 
Back to Top Icon:
Use this option, to browse a icon for Back To Top Button.
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Page Options

 

 

Display Page Title

Use this option to turn on or off the page
title.
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Post Options

 

Display Post Title

Use this option to turn on or off the post
title.
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Widget Options
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Log in Button Text

Use this option to provide the text on login
button.

Log out Button Text

Use this option to provide the text on logout
button.

Hide widget on

By using this option, you can hide this widget on desired
pages.
You can select the pages from the list of the pages.

Select All/ UnSelect All

You can select all pages by clicking on the Select All button. Similarly, you can unselect all
pages by clicking on the UnSelect All button

Block Style

You can select the desired style for your widget.
There are three options available
 
Default:
The widget will be displayed with the TemplateToaster widget styles inside sidebar(s) & with
default styles inside rest of the widget areas.
 
None:
The widget will be displayed with default styles on all the widget areas and sidebar(s).

 
Block:
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The widget will be displayed with the TemplateToaster widget styles on all  the widget areas
and sidebar(s).

 

Menu Display

Using this option, you can select the appearance of your custom menu.
 
There are two options available
 
No Style:
The menu will be displayed with default styles. You can change the colors of Active, Hover
and Normal Links of your custom menu.
 
TT Default:
The menu will be displayed with TemplateToaster styles.

Menu Style

You can choose whether you want to show the custom menu horizontally or
vertically.

Colors

The colors option is only available when your Menu Display is in No Style
mode.
 
Active Color:
Co customize the Actieve link color.
 
Hover Color:
It is the color of the menu link when we hover on it.

 
Normal Color:
It is the color of regular menu link.

.
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Joomla

 

Folder/ Zip:
To export the template as folder or zip, select desired option.
 
RTL:
To make your template design RTL(for Right to Left languages like Arabic), click on this check
box.
 
VirtueMart Compatible:
To make your template compatible with VirtueMart plugin of Joomla, click on this check box.
 
File Name:
Desired name of your template.
 
Path:
Browse the path where you want to export your template, by clicking on Browse button.
 
Export:
Click on this button to export the template.
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Installation

 

 
After logging in to joomla backend, Go to Extensions > Extension Manager.

Browse

Browse the path to your template by clicking on Browse button and then click on Upload &
Install.

Template Manager

  Now go to Extensions >Template Manager to set your newly installed template as your
default template by clicking on Default button.
 
  - Configuration of Menu :
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To add a new menu in your template, Go to Menus >Menu Manager >Add New Menu. Now
you can add menu according to your requirement.
 
– Configuring Horizontal Menu:
Go to Extensions >Module Manager and then select the menu which you want to place as
horizontal menu. Click on that menu name and place the menu on 'Menu' position of your
template from Position option.
 
– Configuring Sidebar Menu:
Go to Extensions >Module Manager and then select the menu which you want to place as
vertical menu. Click on that menu name and place the menu on 'Left' or 'Right' position of
your template from Position option.
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Drupal

 

 
Version:
For choosing the Drupal version, TemplateToaster supports Drupal Version 6 & 7.
 
RTL:
To make your theme design RTL(for Right to Left languages like Arabic), click on this check
box.

 
Folder Name:
Desired name of your theme.
 
Path:
Browse the path where you want to export your theme, by clicking on Browse button.
 
Export:
Click on this button to export the theme.



 

174  | TemplateToaster

 
Installation

 

Appearance

After logging in, click on button "Appearance" and then click on "Install New Theme". Browse
the path to the theme after clicking on Browse button.
Click on Install button to install the theme.
 

 
After installation click on Enable Newly Added Themes. Go to the bottom of the page and
click on Enable and Set Default link provided below the name of the newly added theme, to
set it as default theme.
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Configuring Blocks :
 

 
To configure the blocks, follow the steps given below:
- Login as administrator.
- Go to the Structure option located in Admin tool bar at the top of the page.
- Select “Blocks” option from the menu.
- Change the settings according to the requirement.
- Go to the bottom of the page and click “Save Blocks” to save the configuration.
- Go to home page to see the changes take effect.
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Magento

 

Folder/ Zip:
To export the template as folder or zip, select desired option.
 
RTL:
To make your template design RTL(for Right to Left languages like Arabic), click on this check
box.
 
File Name:
Desired name of your template.
 
Path:
Browse the path where you want to export your template, by clicking on Browse button.

 
Export:
Click on this button to export the template.
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Installation

 

 
Magento template installation guide
 
1.) Copy theme files

a.) On XAMPP, WAMPP etc. (If you want to install Magento template on Local PC)
i) Export the theme as .zip file.
ii) Extract the zip file to the Magento root folder.

b.) On Hosting Server (If you want to install Magento template on Hosting Server)
i.) Export the template as folder.
ii) Upload the content of the folder to the root of Magento directory.
Please refer to the above screen shot.

2.) Do Following:
a.) Open your Magento administration panel and go to System > Design Section.
b.) At the appeared screen click Add New Design button in the top right corner.
c.) In the Custom design field select your newly installed template.
d.) Click Save button to apply changes.
 

3.) Create a category as subcategory to your template default category. This must be
inactive to be hidden in the main navigation. This category will be for “Home page products”.
Remember the ID of this category. See the image below.
 
4.) Once category is created it is good to add several products to it.
 

 



 

178  | TemplateToaster

Add/Creating a Static Block (Optional)
 
- Log into your Magento store’s admin.
- Navigate to CMS>Static Blocks.
- Click Add New Block in the top right corner.
- Give your block a Block Title.
- Give your block an Identifier which will be used to call the block. Make sure the Identifier is
all lowercase and separated by underscores to follow
  Magento’s nomenclature i.e. your_block_id.
- Choose what store view the block belongs to. Just leave as All Store Views unless you have
a good reason not to Set Status to Enabled.
- Enter your HTML in the Content field.
- Click Save Block or Save and Continue Edit to save your settings.
 
Add block in xml (Optional)
 

 
- Open the cms.xml from app > design > frontend > default > your_theme > layout folder.
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- UnComment the above code. “BlockReferenceName” is the name of the area where static
block has to be placed.
- This code will place the block “your_block_id” that you have created in the admin above the
content on the category pages (notice the before=”-”    attribute, which makes sure your block
gets displayed before the rest of the content).
- To add more block paste above code and assign the appropriate “BlockReferenceName” and
“your_block_id”.
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E107

 

Folder/ Zip:
To export the theme as folder or zip, select desired option.
 
RTL:
To make your theme design RTL(for Right to Left languages like Arabic), click on this check
box.
 
File Name:
Desired name of your theme.
 
Path:
Browse the path where you want to export your theme, by clicking on Browse button.
 
Export:
Click on this button to export the theme.
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Installation

 

 
    Login as administrator.
    - If theme default size is greater than 1 MB then open the e107_handlers/theme_handler.php and
find
    <input type="hidden" name="MAX_FILE_SIZE" value="1000000" /> in the file and replace it with
    <input type="hidden" name="MAX_FILE_SIZE" value="10000000" />
    - Go to the Tools option located in the menu.
    - Select Theme Manager option from the Tools drop down menu.
    - Browse the exported theme and click on Upload Theme button.
    - Find the uploaded theme in theme list and then click on Set As Site Theme button.
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    Configure Modules:
 
    - Go to the Content option located in the menu.
    - Select Menus option from the Content drop down menu.
    - Change the settings according to the requirement.
    - Go to home page to see the changes take effect.
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HTML

 

 
Folder/ Zip:
To export the HTML Website as folder or zip, select desired option.
 
RTL:
To make your HTML Website RTL(for Right to Left languages like Arabic), click on this check
box.
 
File Name:
Desired name of your HTML Website folder/zip.
 
Path:
Browse the path where you want to export your HTML Website as folder/zip, by clicking on
Browse button.
 
Export:
Click on this button to export the HTML Website as folder/zip.
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Installation

 

 
                Upload as described in the above screenshot.
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